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Question # 1
How To generate GIF capability files for internet?

Answer:-
If you wish to publish some urdu/arabic/persian material on internet you can use .GIF generating capability of InPage to make pages for web. For this you will need
to look at the Export Page menu item of File menu.
If you have already laid out a page in InPage, then you can export-
The complete page by opting for the Pages From/To radio button. The page will be exported in GIF format and will be saved under the .GIF file. You can now
proceed to use this file in your HTML pages.
Â· one or more selected object by opting for the Selected Objects radio button. In this case if you want to put a newspaper page on internet then you can first generate
.GIF files for the headlines by selecting the individual text or title text boxes and using this Export Page command. Later on you can generate .GIF files for the
columnar text containing various newspaper stories by selecting and generating .GIF for these linked text boxes.
Read More Answers.

Question # 2
How To generate PDF files for internet?

Answer:-
InPage can generate .PDF file if you have installed the Adobe Distiller driver. Then you can use the Print command in InPage to generate a .PDF file. An internet user
can use Adobe's Acrobat reader to read and print this .PDF file. But please note that since InPage uses quite a number of fonts, these files can become bery big.
Read More Answers.

Question # 3
How To generate oostscript files for internet?

Answer:-
You can also generate Postscript files by using a standard postscript printer driver like Linotronic 330 and printing to a file. While printing you should ensure that
'Send Truetype as Type 1' has been set on in the Advanced Option dialog.
Read More Answers.

Question # 4
Can I intermix Arabic-Persian with Urdu?

Answer:-
You can intermix arabic - persian text with nastaliq and naskh styled urdu text by changing to a different font (for example Trad Arabic, Aasaar, etc.) when you need
to enter arabic or persian. For example, see the following line with arabic text (with aeraabs) juxtaposed alongside urdu.
Read More Answers.

Question # 5
Can I intermix English with Arabic, Urdu and Persian?

Answer:-
If you wish to enter English as well, you can do so by entering in the same line by first toggling to English entry mode and entering English on the same line.
Now as you can see the English text spills over to the next line and actually comes below the Arabic text. If you wish to have columnar text of Arabic followed by
columnar text of Urdu and columnar text of English, then you have two options.
Read More Answers.

Question # 6
How to Use tables in InPage?

Answer:-
* Insert a table using Table menu item in the Insert menu and choose a three columnar table.
* Set the font of the first column (by first selecting the column by double clicking) to Trad Arabic, second column to Noori Nastaliq. Other attributes like Forced
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Justify, Line Direction etc. can also be separately applied to each column in the table.
* Click on first column and enter Arabic text. Press Tab key when you have finished with Arabic entry.
* Enter the Urdu translation in the second column. Press Tab key at the end.
* Now toggle to English entry mode in the third column. Enter the English translation in this column.
Read More Answers.

Question # 7
How to Use multiple text chains in InPage?

Answer:-
This option is useful if you wish to have continuous Arabic, Urdu and English text (for example an Urdu and English translation of The Holy Quran). In this case
follow these steps-
* Make a new Right To Left document without automatic text box. If need be make a double sided document.
* Go to Master Page mode by clicking on the Master Page button. On the master page, make three independent and un-linked text boxes.
* Change over to the document mode by clicking again on Master Page button. In the document area, you can set fonts for each of the text chain.
* For the first column, click on the text box by clicking with I-Beam tool and set the font of this text chain by double clicking and setting the font to Trad Arabic font
from the Urdu fonts combo box.
* For the second column, click on the second text box by clicking with I-Beam tool and set the font of this text chain by double clicking and setting the font to Noori
Nastaliq font from the Urdu fonts combo box.
* For the third text box, set the line direction of the paragraph to Left to Right.
* If required set the justified option to Full Justify for all the three text chains.
* Now you have the basic infrastructure for entering Arabic text in the first text chain, Urdu text in the second text box and English text in the third text box.
Read More Answers.

Question # 8
Can I use mathematical equations in InPage?

Answer:-
You can use InPage to inter mix mathematical equations with urdu/english text. These equations will need to be entered in MS Windows compatible software which
supports equation. One such package is Microsoft's Equation Editor.
Read More Answers.

Question # 9
If there's any problems in baseline alignment of equation and urdu text, Then what to do?

Answer:-
If you have problems in baseline alignment of equation and Urdu text, it is suggested that you go to the Normal style sheet (from Format Style sheet menu item) and
modify the baseline shift in Character dialog to -2 pt. This will lead to shifting of complete Urdu text by -2 pt and the text and equations will align on the baseline.
Read More Answers.

Question # 10
How to use mathematical equations in InPage?

Answer:-
First run Equation Editor.
* In In-Page, position your caret at the point where you wish to insert the equation.
* Now go to Equation Editor (by using standard Windows application switching short cut key sequence-Alt-Tab). Type in the equation in the Equation Editor. Copy
the equation from the editor and then paste it in In-Page at the caret position.
* You will notice that the equation gets pasted as an inline picture. Thus at any point in the text you can paste such equations. Because these equations get pasted as
Windows meta-file, there will not be any loss in print quality when you take a print out.
Read More Answers.

Question # 11
How to use corel draw with InPage?

Answer:-
With InPage, you can now enter text in Urdu, copy the text box and paste it in Corel Draw 5.0. The various steps are-
* First run InPage.
* Now launch Corel Draw.
* Make a headline in InPage by first creating a text box or a title text box and entering Urdu in the text box.
* Once the text has been completely entered, select the Arrow Tool from the tool strip and now select this text box in the arrow mode.
* Copy this text box onto the clipboard by using the Copy command.
* Now switch to Corel Draw and paste the text box you have already copied onto the clipboard.
* Go to the Arrange menu and choose Ungroup.
* Sometimes a text box appears as a frame when you paste the text in Corel Draw. After ungrouping, you can select the frame and delete the extra frame.
* Now select the complete text using the selection rectangle and choose Combine menu item from the Arrange menu.
Read More Answers.

Question # 12
How to use diacritical marks & special symbols?

Answer:-
InPage allows you to use all the diacritical (or Aeraabs) marks used in Urdu, Arabic, Kashmiri and other Perso-Arabic Scripts. For details view the keyboard through
Keyboard Preferences. Many special symbols have also been provided. Some of these can be entered using the keyboard whereas others can be inserted in the textbox
from the Symbol menu.

Copyright © https://globalguideline.com Page 3/20

https://globalguideline.com/interview_questions/
https://globalguideline.com/interview/questions/InPage
https://globalguideline.com/interview/question/How_to_Use_tables_in_InPage
https://globalguideline.com/interview/question/How_to_Use_multiple_text_chains_in_InPage
https://globalguideline.com/interview/question/Can_I_use_mathematical_equations_in_InPage
https://globalguideline.com/interview/question/If_theres_any_problems_in_baseline_alignment_of_equation_and_urdu_text_Then_what_to_do
https://globalguideline.com/interview/question/How_to_use_mathematical_equations_in_InPage
https://globalguideline.com/interview/question/How_to_use_corel_draw_with_InPage
https://globalguideline.com


InPage Interview Questions And Answers

Global Guideline . COM

Read More Answers.

Question # 13
How To Layout A Ghazal?

Answer:-
* Insert a Table with three columns. The extreme left and extreme right columns are to be used for entering ghazal text. The middle column will be used for
controlling space between the text.
* Set the table width of the extreme right column (column no. 1) and extreme left (column no. 3) to 3 cm. Set the middle column to 0.2 cm. Set the Table Alignment
to Centered. All these operations are to be carried from Format Table menu item in Format menu.
* Select all the columns and click on the Forced Justify icon from the Text Ribbon.
* Now enter Urdu text in column no. 1. Follow it up with two tabs to reach column no. 3 and enter the corresponding second part of the couplet.
* Continue till you have entered all the four lines.
* For the bottom portion of the ghazal, enter one column table and specify the width as 3 cm. Again select the column and set the Forced Justify option.
* Now enter Urdu text for the bottom portion of the ghazal.
* Repeat the above steps till you have laid out the complete ghazal.
Read More Answers.

Question # 14
How To Layout A ghazal by using style sheet functionality?

Answer:-
* Create a style sheet by choosing the Style sheet menu item from the Format menu and clicking on the New button in the ensuing Style sheet dialog.
* Enter the name of the new style sheet as lets say 'Right' and click on OK button.
* Now click on the Paragraph button and specify the beginning indent (from left) as 5 cm and end indent (from right) as 2 cm. Also choose the Alignment as Forced
Justify.
* Enter the keyboard shortcut for the style sheet as 'R'.
*  Make another style sheet and call it 'Left' with keyboard shortcut as 'L'.
* Specify the beginning indent as 2 cm and end indent as 5 cm.
* Once you have these style sheets, you can use Ctrl+Shift+R and Ctrl+Shift+L to apply the style sheet to the current paragraphs.
* First apply Ctrl+Shift+R and enter first two lines of Urdu text.
* Now apply Ctrl+Shift+L and enter next two lines of Urdu text.
* Repeat the last two steps till you have entered the complete ghazal.
Read More Answers.

Question # 15
How to layout an Urdu-English Dictionary?

Answer:-
* Insert Table by using the Table menu item in the Insert menu.
* Specify number of columns (2 in this case) required along with its width if any. If you do not specify the width of the column, the text box width will be divided by
number of columns required and you will get the default column width.
* Select the right column & click on Arabic character alignment button.
* Select the left column & click on the Latin character alignment button.
* Now start in Urdu entry mode and enter Urdu text. Once the text has been entered in a cell, press Tab.
* In this cell switch to English entry mode and enter the English text.
* Repeat the above steps to completely enter all the Urdu and English text.
Read More Answers.

Question # 16
What minimum hardware need to use Inpage?

Answer:-
* IBM compatible PC 486 and above with at least 32 MB RAM and 50 MB free hard disk space and a VGA Monitor
* Any printer compatible with MS-Windows 95 or later.
Read More Answers.

Question # 17
What is the recommended hardware for inpage?

Answer:-
IBM PC Pentium II with 64 MB RAM and 200 MB free hard disk space.
Read More Answers.

Question # 18
What Software's InPage needs?

Answer:-
InPage needs MS-Windows 95 or later on IBM compatible PCs.
Read More Answers.

Question # 19
What is parallel port memo HASP dongel?
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Answer:-
This dongel is white in color and is attached to the parallel port of your machine. There are two ends of the dongel. One end of the dongel gets attached to the parallel
port of your machine. The printer cable gets attached to the other end of dongel. To install the dongel onto your machine please follow these steps:
* If your computer is already connected to the printer, ensure that the printer is switched off.
* Remove the printer cable from the computer end. Attach one end (male end) of the dongel to the parallel port and screw it tight using the built-in screws provided
with the dongel.
* Now you can attach the printer cable onto this dongel.
* You can switch on your printer if you wish to use it immediately.
The dongel does neither interfere with any other application already installed on your machine nor with any other functionality of your computer like Printing etc.
Once you have correctly and firmly attached the dongel, you can begin installing InPage from the supplied floppy disks.
Read More Answers.

Question # 20
What is USB memo HASP dongel in InPage?

Answer:-
This dongel is blue in color and is attached to the Universal Serial Bus (USB) port of your machine. Before attaching it to the USB port of your machine, please
confirm that in the INTEGRATED PERIPHERALS settings in the BIOS setup when your machine is starting to boot up, you have enabled the USB controller. Also
first install InPage from the CD, then run InPage as per instructions below. InPage will automatically install/update the HASP driver and will prompt you to restart
your machine. Now is the time for you to attach your USB dongel.
Read More Answers.

Question # 21
What is net HASP LAN dongel in InPage?

Answer:-
This dongel is red in color. The dongel is attached to the parallel port of the machine which you wish to make a server. The server need not be dedicated. The
terminology 'server' is used to signify that a software called 'License Manager' will run on this machine. The License Manager is a file called NHSRVW32.EXE
found inside the SERVER sub-directory inside HASP.
Read More Answers.

Question # 22
What is cryp key software protection in InPage?

Answer:-
If your software comes with a software protection then you will need to get the correct site key after emailing the site code to the appropriate email address. The
details of this will get automatically displayed when you launch InPage for the first time. If you are using Windows NT, please ensure that you are in logged in with
Administrative privileges before installing InPage.
Read More Answers.

Question # 23
What elements make up the InPage window?

Answer:-
* Toggle for English/Urdu/Sindhi Entry
* Tools
* Ribbon
* Status Bar
* Rulers
* Document Area
* Scroll Bars
Read More Answers.

Question # 24
What is toggle language in InPage?

Answer:-
The language toggle command lets you switch between English, Urdu and Sindhi Entry Mode. You can use either use Ctrl-Space key combination or the Toggle
menu command from the Language menu to switch between these language entry modes. The selected language gets displayed in the Status Bar at the bottom of the
Window. In the Urdu Entry Mode, you can not only type Urdu but Arabic, Persian, and other Perso-Arabic scripts. Usually a keyboard is provided for each language
that is there. For changing the selected keyboard, you will need to go to the Keyboard Preferences in the Preferences menu item of the Edit menu.
Read More Answers.

Question # 25
What is Ribbon in InPage?

Answer:-
As you move about selecting and un-selecting objects or text, the ribbon changes to display the correct attributes of the selected object or text. It also allows you to
modify one or more attributes of the object or text. There are six types of ribbon:
* Object Attributes Ribbon. One or more of InPage objects (Text box,
Title Text box, Picture box, Graphic box, Line) are selected.
* Text Attributes Ribbon.
* Picture Edit Ribbon.
* Inline Graphics Ribbon.
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* Tabs Ribbon.
* Paste Ribbon.
* When neither object nor text is selected. Ribbon is either blank or reflects the ribbon for the selected tool.
Read More Answers.

Question # 26
What is Status Bar master page button in InPage?

Answer:-
Master Page Button.
Allows you to view either the master pages or the document pages. If the master page button is selected on then you can view and work on the master pages. On the
other hand if it is off then you can view and work on the document pages.
Read More Answers.

Question # 27
What is Status Bar page scroller button in InPage?

Answer:-
If the master page button is selected on then the Page Scroller lets you scroll the master pages. If the master page button is off, then you can scroll the document
pages. You can scroll by clicking the left and right arrow of the Page Scroller. You can also go to a specific page by entering that page number and pressing
enter/return.
Read More Answers.

Question # 28
What is status bar view button in InPage?

Answer:-
View lets you control scaling of your document. You can enter whatever percentage scaling is desired. On clicking enter/return the document gets scaled to the
entered percentage.
Read More Answers.

Question # 29
What is The rulers in InPage?

Answer:-
Both vertical and horizontal rulers are provided for proper measurement guidance during creation and modification of objects. The ruler area is also used for creation
of guides.
Read More Answers.

Question # 30
What is the origin box in InPage?

Answer:-
Clicking and dragging on the Origin Box and leaving the Cross cursor at the desired position on the page enables you to set the ruler origin to that point on the page.
Read More Answers.

Question # 31
What is the document area in InPage?

Answer:-
The Document Area is where you can create and edit various kinds of objects like Text boxes, Picture Boxes, Graphic Boxes, Lines etc. This area is made up of
visible Pages and global Pasteboard (area around the visible pages). Pasteboard is for temporary storage of objects on pasteboard do not from part of the document
and are not printed out.
Read More Answers.

Question # 32
What is the scroll bar in InPage?

Answer:-
There are two scroll bars, Vertical Scroll Bar for vertical scrolling of the document area and Horizontal Scroll Bar for horizontal scrolling.
Read More Answers.

Question # 33
What are the cursors in InPage?

Answer:-
As you move the mouse on the screen, the cursor shape changes to reflect the kind and status of the object immediately underneath. If the currently selected tool in
the Tool Strip is a creation tool then the cursor is always a CROSS. If you have selected an Arrow cursor then the cursor shape is always an Arrow cursor. On the
other hand if you have selected an IBEAM tool then the cursor shape is always Arrow cursor except on top of the handles of a selected objects, where the cursor
becomes an arrow indicating the direction of resize.
Read More Answers.
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Question # 34
What is the IBEAM cursors in InPage?

Answer:-
IBEAM except on top of text box and picture box when it varies as follows:
* Dotted IBEAM on top any Text box,
* IBEAM on top of a Text box in the currently selected text chain,
* Hand on top of the currently selected Picture Box, and
* Dotted Hand on top of a Picture Box.
Read More Answers.

Question # 35
What are the other cursor shapes in InPage?

Answer:-
* LINK FRAME Cursor. When Text box linking is desired.
* DELINK FRAME Cursor. When Text box delinking is desired.
* Horizontal guide/vertical guide Cursor. Used during creation of guides
* Paste Cursor. Used during paste of objects see the paste menu item of Edit menu.
* Rotation Cursor. When rotation of selected objects is desired.
Read More Answers.

Question # 36
How to use Creation object in InPage?

Answer:-
To create an object, you will first have to select the proper Tool. All the creation tools display the cursor as CROSS. Now click the mouse in the Document Area and
while keeping the mouse pressed, drag the mouse. The Ribbon will show the X and Y coordinates where the mouse was clicked as well as the updated width and
height of the object as mouse is moved. When the required size of the box has been achieved, leave the mouse button. You will now get a selected object with size
attributes as indicated in the Ribbon.You can also create an object by entering its coordinates and its width and height in the Object Ribbon.
Read More Answers.

Question # 37
How to use Selection object in InPage?

Answer:-
For re-sizing, copying, deleting and changing attributes, you need to select an object. You can select an object with an ARROW cursor. For this, first select the Arrow
Tool. If you now click on the object, it will be selected and you ill see highlighted selection points on the object. To select more then one object at the same time,
keep the SHIFT key pressed while other objects are selected with the help of the mouse.
Read More Answers.

Question # 38
How to use moving object in InPage?

Answer:-
To move an object you will first select the Arrow Tool. Now click the mouse on top of the object. The object will get selected and while keeping the mouse pressed
drag the mouse, the object will now move along with the mouse. On leaving the mouse, the new positions of the object gets registered and the changed values are
reflected in the Ribbon.
Read More Answers.

Question # 39
How to use resizing object in InPage?

Answer:-
A selected object has handles using which the object can be resized. Bring the mouse cursor on top of one of these handles. The cursor shape changes to a Resize
ARROW. With this resize cursor, press the mouse and drag while keeping the mouse pressed. Leave the mouse when the required size has been achieved.
Read More Answers.

Question # 40
How to locked an object in InPage?

Answer:-
You can lock an object so as to prevent its accidental movement or deletion. For locking you have to invoke the appropriate object dialog by double clicking on the
object or objects and setting the lock check box as ON. Once you lock an object its selection points appear as gray rather than black (which is the case in normal
selection). Once locked you will not be able to move or delete the object. If you do need to carry out any one of these operations then unlock the object. To unlock a
locked object, you just have to un-check the lock check box in the Format object dialog box. A locked object has selection points (handles) that are grey in color
whereas unlocked objects have black handles.
Read More Answers.

Question # 41
How to marking an object as don't Print in InPage?

Answer:-
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Sometimes there is a need to mark one or more object as Don't Print so as to prevent the object or objects from being printed out. You can do so by checking the
Don't Print check box in the Format Object dialog. To reset this attribute you must uncheck this check box.
Read More Answers.

Question # 42
How to marking an object as template object in InPage?

Answer:-
Once an object is marked as Template then that object behaves as a master mould. You can make exact replicas of the template object by just dragging the template
object.Instead of moving the template object, the dragging operation peels off an identical copy of the template object. You would usually make a template object in
the pasteboard.
Read More Answers.

Question # 43
How to Cut, Copy, Clear and Paste of objects in InPage?

Answer:-
Objects can be copied to clipboard, or pasted from clipboard. Cut and Clear both delete the selected objects. Whereas Cut copies the objects to the clipboard, clear
just deletes the selected objects. Copy on the other hand copies the selected objects to the clipboard without deleting the objects. Once the objects have been copied to
clipboard, they can be pasted by invoking the Paste command. On invoking the Paste command the cursor changes to Paste cursor. You can click with this cursor
anywhere on the page. All the objects on the clipboard are pasted with respect to this clicked reference point. If your document type is left to right then this point is
treated as left top of the boundary rectangle outlining all the selected objects. On the other hand if your document type is right to left then this point is treated as right
top of the boundary rectangle.
Read More Answers.

Question # 44
How to duplicate objects in InPage?

Answer:-
Duplicate enables you to duplicate a group of selected objects in a tabular format. The duplicate dialog asks you information as to number of rows and number of
columns in which the duplicated objects will be arranged. You will also be asked to specify column and row gap so as to offset each row of objects by this gap and
each column by the column gap. 
Note that duplicate treats the selected objects as a group and while duplicating calculates the outer bounding rectangle of this group of objects.
Read More Answers.

Question # 45
How to Text Run Around Objects in InPage?

Answer:-
When objects are placed on top of text box containing text, then you can control text run around these objects. By default text boxes and picture boxes have the
runaround option ON. That is, these objects when placed on top of text box with text will lead to text getting repelled from these objects unless you choose Run
Around menu option from the Format dialog and un-check the Run Around check box. Whereas for graphic boxes and lines, run around option is OFF. Besides these
default values, you can specify the distance that text will flow away from the object.
Read More Answers.

Question # 46
How to use object rotation in InPage?

Answer:-
All the objects in an InPage document can be rotated.The rotation is carried out in Object Selection mode i.e. with the Arrow key. Once the object has been selected,
it can be rotated by specifying the angle of rotation in the Object dialog or by selecting the rotation tool and rotating the object.
Read More Answers.

Question # 47
Inpage shortcut keys list part 1:

Answer:-
* Previous Character 	Left Arrow
* Next Character 	Right Arrow
* Previous Word 	Ctrl+Left Arrow
* Next Word 		Ctrl+Right Arrow
* Previous Line 	Up Arrow
* Next Line 		Down Arrow
* Top of Previous 	Text box Alt+Up Arrow
* Top of Next Text box	Alt+Down Arrow
* Top of Paragraph 	Ctrl+Up Arrow
* Top of Next Paragraph Ctrl+Down Arrow
Read More Answers.

Question # 48
Inpage shortcut keys list part 2:

Answer:-
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* Beginning of Line	Home
* End of Line 		End
* Beginning of Story 	Ctrl+Home
* End of Story 		Ctrl+End
* Select Word 		Double Click
* Select Paragraph	Triple Click
* Shift pressed with above keys selects the text till caret position.
* Toggle English and Urdu   Ctrl+Space
* Delete Previous Character Backspace
* Delete PreviousWord 	    Ctrl+Backspace
Read More Answers.

Question # 49
Inpage shortcut keys list part 3:

Answer:-
* Delete Next Character 	Del
* Delete NextWord 		Ctrl+Del
* Cut 			        Ctrl+X, Shift+Del
* Copy 			        Ctrl+C,Ctrl+Insert
* Paste 			Ctrl+V,Shift+Insert
* Undo Previous Operation 	Alt+Backspace, Ctrl+Z
* Select All 		        Ctrl+A
* Find Text    		        Ctrl+F
* Replace Text 		        Ctrl+R
* Bold 			        Ctrl+B
Read More Answers.

Question # 50
Inpage shortcut keys list part 4:

Answer:-
* Italics			Ctrl+I
* Left Alignment 		Ctrl+Alt+L
* Right Alignment 		Ctrl+Alt+R
* Center Alignment 		Ctrl+Alt+C
* Justified			Ctrl+Alt+J
* Full Justified 		Ctrl+Alt+F
* Toggle Text and Tab Modes 	Ctrl+Alt+T
* Define Style Sheets 	        Ctrl+T
* Character Format 		Ctrl+H
* Paragraph Format 	        Ctrl+G
Read More Answers.

Question # 51
Inpage shortcut keys list part 5:

Answer:-
* Increase Character Spacing	 Ctrl+F5
* Decrease Character Spacing    Ctrl+F6
* Baseline Shift Up 		Ctrl+F7
* Baseline Shift Down 	        Ctrl+F8
* Decrease Font Size 	        Ctrl+F9
* Increase Font Size 	        Ctrl+F10
* Index Entry 		        Ctrl+Alt+I
* Table Of Contents 	        Ctrl+Alt+0
* Spell Check 		        Ctrl+L
* Select All Objects 	        Ctrl+A
Read More Answers.

Question # 52
Inpage complete shortcut keys list part 6:

Answer:-
* D/Select Multiple Objects 	Shift+Mouse Click
* Delete 			Del
* Cut 			        Ctrl+X
* Copy 			        Ctrl+C
* Paste 			Ctrl+V
* Undo Previous Operation 	Alt+Backspace, Ctrl+Z
* Smaller Movement 	Ctrl+ArrowKeys
* Group 		Ctrl+Alt+G
* Ungroup 		Ctrl+Alt+U
* Smaller Movement 	Ctrl+ArrowKeys
Read More Answers.
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Question # 53
Inpage complete shortcut keys list part 7:

Answer:-
* Delete 		Del
* Cut 			Ctrl+X
* Copy			Ctrl+C
* Paste 		Ctrl+V
* Fit in Window 	F5
* 50%			F6
* Actual		F7
* 200% 			F8
* Zoom In Right 	Button Click
* Zoom Out 		Shift+Right Button Click
Read More Answers.

Question # 54
Inpage complete shortcut keys list part 8:

Answer:-
* Scroll Page Up 	Page Up
* Scroll Page Down	Page Down
* Scroll Page 		Left Ctrl+PageUp
* Scroll Page Right 	Ctrl+Page Down
* Scroll Page Up One Line 	Shift+PageUp
* Scroll Page Down One Line     Shift+Page Down
* Scroll Page Left One Line 	Ctrl+Shift+PageUp
* Scroll Page Right One Line 	Ctrl+Shift+Page Down
* Previous Page 		Alt+PageUp
* Next Page		        Alt+Page Down
Read More Answers.

Question # 55
Inpage complete shortcut keys list part 9:

Answer:-
* First Page 		Alt+Home
* Last Page 		Alt+End
* Delete Pages 		Alt+Del
* Insert Pages 		Alt+Ins
* Create a New Document 	Ctrl+N
* Open an Existing Document     Ctrl+O
* Save Document       	        Ctrl+S
* Save As Document 	        Ctrl+Alt+S
* Send an Email 		Ctrl+M
* Toggle Master and Document pages	 Alt+Enter
Read More Answers.

Question # 56
Inpage complete shortcut keys list part 10:

Answer:-
* Print Document 		Ctrl+P
* Print Setup 		         Ctrl+Alt+P
* Close Document 		Ctrl+F4
* Import Text or Picture 	Ctrl+Y
* Export Text or Picture 	Ctrl+Alt+Y
* Text box			 Shift+F2
* Title Text box 		Shift+F3
* Link Text box 		Shift+F4
* Picture Box 		        Shift+F5
Read More Answers.

Question # 57
Inpage complete shortcut keys list part 11:

Answer:-
* Elliptical Picture Box 	Shift+F6
* Round Cornered Picture Box 	Shift+F7
* Graphic Box 		        Shift+F9
* Elliptical Graphic Box	Shift+F10
* Round Cornered Graphic Box  Shift+F11
* Line 			        Shift+F12
* Help 			        F1
* StoryEditor 		        F2
* Snap To Guides 	 	F9
* TypographicPreferences 	F11
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Read More Answers.

Question # 58
Inpage complete hot shortcut keys list part 12:

Answer:-
* Application Preferences 	Alt+F11
* Document Preferences     	Ctrl+F11
* Go to last edited-		F12	
* Go to Page Scroller-	        Alt+F12	
* Go to the View in Status Bar 	Ctrl+F12
* AbortCurrentImport of Text 	Escape
* Exit 			        Alt+F4
* Tabs within a Table Cell 	Ctrl+Tab
Read More Answers.

Question # 59
Inpage complete hot shortcut keys list part 13:

Answer:-
* Application Preferences Double Click On Tool Strip
* Typo graphic Preferences Double Click On Text Ribbon
* Format Guides Double Click On Rulers
* Reset Ruler Origin Double Click On Origin Box
* Page Scroll Ctrl+LeftButton Click
* Create Objects with handles Double Click on the Tool(for Text,Title and Picture Boxes)
* Open Files from File Manager Drag Drop InPage File Import
* Picture from File Manager Drag Drop Picture File Import
Read More Answers.

Question # 60
Inpage hot shortcut keys list part 14:

Answer:-
* Move Selected Objects in direction of arrow key Arrow Keys
* Move Selection Point Arrow Keys with mouse down
* Smaller Movement of Selection Point Ctrl+Arrow Keys with mouse
* Constrain Movement Vertically or Horizontally Shift while moving objects
* Move Objects to Original Position Escape while moving Objects
* Make Object to Square or Circle Shift while modifying an Object
* Make Line at any angle Shift while modifying a line
* Text from File Manager Drag Drop Text File
Read More Answers.

Question # 61
How do I print my document as mirrored?

Answer:-
You can take printouts in mirror fashion only on Postscript printers by using the mirror feature in-built in Postscript printer drivers.
Read More Answers.

Question # 62
I am intermixing English with Urdu but why the English text appears
bigger than urdu text?

Answer:-
A 12 pt English text is bigger than a 12 pt urdu text. We have an option in the Typographic Preferences where you can set the 'Reduce Latin Font size' field. By
default this is set to 18%. That at the same point size, English text will be reduced by 18%. You can modify this value to suit your needs.
Read More Answers.

Question # 63
I am changing font but the font is not getting applied, How to fix?

Answer:-
This is because you have not selected the text to which you are applying the font. For all the character attributes (like font change, font size, bold, italic, inter
character gap, baseline shift etc.) you will always need to select the text to which you are applying these attributes.
Read More Answers.

Question # 64
When I open a file, I get a message "This is not an InPage document, How to fix?

Answer:-
Probably you are actually opening a document file of some other application. In case you are sure that you are opening an InPage document, then its quite
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possible that on your last save the file was not saved properly. At this juncture you have the option to open the .BAK file and retrieve your document before the last
save state.
If you get the above message (from opening the .BAK file as well), then you can try retrieving only the text portion of your document (without any formatting) by
importing the saved file as a text file in a new document. When you use the Import Text menu item and you get a Import Text dialog box, you should choose the file
type as Text File (*.txt). This will lead to insertion of some junk characters at the beginning of the document and after 8-9 pages you will start getting
Urdu/Arabic/English text. You can remove the junk characters from your document and make fresh changes to this newly retrieved document.
Read More Answers.

Question # 65
I have saved the file but when I open it I find blank pages?

Answer:-
Probably before saving, you had changed to Master Page mode. And if you do not have any object or if you have empty text boxes on the master page(s), it will seem
that the document is empty. To rectify this, go back to document mode (by pressing Alt-Enter or clicking on Master Page icon).
Read More Answers.

Question # 66
How do I enter Arabic or Persian text in InPage?

Answer:-
You can enter Arabic or Persian text as part of Urdu text entry with one of the many naskh fonts. See the section on 'Working with Text' in the manual.
Read More Answers.

Question # 67
How to fix if I wish to enter sindhi text but I cannot locate sindhi toggle button?

Answer:-
There is an 'Enable Sindhi' check box in the Keyboard Preferences in the Preferences menu item of Edit menu. Please ensure that the check box is checked On. One
this is On, the Sindhi toggle button appears next to the Urdu toggle button.
Read More Answers.

Question # 68
What to do if InPage works with printer On and does not work if the printer is switched off?

Answer:-
Usually this problem has been seen to occur with Windows 95. To resolve this, on the Detail tab of the printer Properties screen, choose the Port Settings button, and
set the 'Check port state before printing' check box to off.
Read More Answers.

Question # 69
When I launch InPage, I get a message "<no> of fonts not installed"?

Answer:-
* As a first step, you can scan your disk by running the scandisk utility from Windows.
* Now you can relaunch InPage and if you still encounter the same message then reinstall InPage completely.
* It is also possible (in Windows 3.1/3.11) that 'Enable True type fonts in application' check box is set to off in the Fonts dialog from Control Panel folder. In this case
too, you will get the above message and you will need to set this check box on and relaunch InPage.
Read More Answers.

Question # 70
When I launch InPage, the program displays a "Dongel not installed message, How to fix it?

Answer:-
* Please check that you have securely attached the dongel (that came along with your InPage installation) to the parallel port.
* If you still get the above message, carry out these steps:
* check that your printer is off
* detach the printer cable from the dongel,
* reattach the dongel,
* attach the printer cable on top of the dongel,
* restart your computer,
* switch on your printer if required, and
* now switch on your computer.
* Launch InPage again.
Read More Answers.

Question # 71
How to printing through postscript printers in InPage?

Answer:-
* For Postscript printers, from the Options dialog you can choose the Advanced options button. In this dialog box, you can either send True Type fonts as postscript
fonts or as Bitmap. For printing to printer without the downloaded fonts, you should select the Send True Type as Type 1 option.
* If you want to print using already downloaded fonts, you should print through a printer driver which supports the following options. Adobe Default Printer driver or
Accel-A-Writer printer drivers are two such drivers. Within the True Type font option set "Don't Send" True Type fonts. Also within the Postscript option check the
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"Do not download fonts" check box. Now if you print, the postscript file which is sent to the printer does not have font information. It just has the names of the fonts,
and the font information it picks up from the printer. This is useful for a newspaper and/or magazine environment where you can download all the fonts you need.
You can download these fonts to the printer memory or better still download these fonts to the printer hard disk.
* Downloading fonts to the Printer Hard disk
Read More Answers.

Question # 72
How to printing in InPage?

Answer:-
Printing can be carried out on any of the MS-Windows compatible printers. You first need to ensure that you are printing to your printer using a compatible driver
from MS-Windows. You can choose or change the printer
driver from either the Printer Setup dialog or the Setup dialog from the Print command. In this dialog, you can set the following options:
* Choose a Specific or default Printer,
* Set Printer Paper Orientation whether Portrait or Landscape,
* Set Printer Paper Sizes,
* Using the Options button you can setup advanced Printer options.
The ensuing Options dialog varies from printer driver to printer driver. In general there is a clear demarcation between Postscript printers and non postscript printers.
Read More Answers.

Question # 73
How to inserting inline pictures in InPage?

Answer:-
To insert inline graphics inside a text box, you need to use the insert picture menu item. This is very useful for manuals and books where the picture should flow
along with the text. Once inserted, the inline picture can be resized and cropped by first selecting it and then carrying out the desired operation.
To select an inline picture, you just need to select the picture character with either the mouse or by using Shift along with the arrow key. Once selected, three
selection points appear. These selection points enable you to resize the picture. Note that you cannot move the picture because its left and top is decided by the
characters before this and the line height. Similarly if you move the mouse over the selected picture, a dotted Hand cursor tracks your movement over the picture. If
you now click on the picture with this dotted hand cursor, the cursor changes to solid hand cursor. You can now crop the picture by moving the mouse.
Read More Answers.

Question # 74
How to inserting page number in InPage?

Answer:-
You can insert a page number character to display the current page number at this character position. Usually you will use this to insert a page number on the master
page in a title text box. This will enable the page number to get displayed on all the pages. On the master page the page number character is displayed as a hash (#).
Read More Answers.

Question # 75
How to text wrap and repel in InPage?

Answer:-
To enable text to runaround an intersecting object, the text wrap attribute of the text chain has to be set to on. The amount the text flows away from the object is
controlled by the specifications of the Object Runaround dialog.
Read More Answers.

Question # 76
What are style sheets in InPage?

Answer:-
If you are working on a long document like book or a manual like this User manual, then you can exploit the power of Style Sheets. Style sheet is a collection of
Character, Paragraph, Hyphenation and Borders attributes. This collection of attributes is given a name-a Style sheet name. Now whenever you want to apply the
same set of attributes to some other paragraph, then you just need to apply the appropriate style sheet either from the style sheet combo box in the ribbon or the
Format Style Sheets dialog. Later on if you want to modify some of the attributes you need to open the Format Style Sheets dialog and modify an existing style sheet.
On pressing Enter, all the paragraphs to which this style sheet has been applied get formatted with the new attributes. This enables speedy formatting of your
document.
Read More Answers.

Question # 77
What are borders in InPage?

Answer:-
You can apply borders before and after a paragraph (much like See Also and Note paragraphs in this manual). The Borders can also be given a line pattern style
(whether dotted, dashed, dash-dotted etc.), its thickness and color too can be specified.
Read More Answers.

Question # 78
What is Hyphenation in InPage?

Answer:-
Hyphenation allows you to hyphenate English words at the end of the line of text in a a paragraph. InPage gives you the capability to specify the density of
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hyphenation in a paragraph.
Read More Answers.

Question # 79
How to entering other Left to Right Languages text in InPage?

Answer:-
You can enter text in other Indian languages like Hindi, Bang-la, Telugu etc. if you the appropriate font. These fonts will appear in the Latin font combo box(box
containing English fonts).
Read More Answers.

Question # 80
How to entering Urdu/Arabic/Persian text in InPage?

Answer:-
To enter text in Urdu/Arabic/Persian you need to interact with the following elements of InPage Interface:
* English/Urdu Toggle Language.
* Keyboard Settings
* Typographic Preferences. For reference go to the details of the Preferences under the Edit menu. To key in Urdu text follow these steps-
* Go to the bottom right of your program window and ensure that the language displayed is Urdu. If not you will either need to use Control-Space or go to the
Language menu item and choose Toggle Language.
* Go to the Keyboard Preferences and choose your favorite keyboard from the list of predefined keyboards. Keeping your Urdu keyboard layout handy for reference,
enter the Urdu text.
* Similarly if you wish to enter Arabic or Persian you can do so by choosing the appropriate font from the font combo box in the text ribbon as well as the right 
keyboard from the keyboard preferences.
For example-
For typing in Urdu      choose    noori nastaliq font
For typing in Arabic    choose    traditional Arabic font
For typing in Persian   choose    aasaar font
Read More Answers.

Question # 81
What is polygon tool in InPage?

Answer:-
* Select the Polygon tool and create a rectangular shaped object with four selection points (please note other objects when created have 8 selection points).
* Now select the Arrow Tool. With this tool, when you bring the cursor near to the boundary of the selected polygon, the cursor
changes shape to a cross with a dot. This cursor signifies that you can add a selection point to the ploygon.
* Click with this Cross with a Dot Cursor where ever you wish to introduce an additional point. Each of selection point can be selected and tweaked to change the
overall shape of the polygon.
* You can repeat step 3 to reach a new polygon.
Read More Answers.

Question # 82
How to drawing a Line at any angle in InPage?

Answer:-
To draw a line at any angle, keep the SHIFT key pressed while creating or modifying the line.
Read More Answers.

Question # 83
How to changing the width of the Line in InPage?

Answer:-
First select the line. Enter the new value in the Width or the line thickness field of the ribbon and press enter/return.
Read More Answers.

Question # 84
How to change the color of the line in InPage?

Answer:-
After having selected the line, select the Fill Color from the Fill Color combo box.
Read More Answers.

Question # 85
What is Creation in InPage?

Answer:-
Select the Line Tool from the Tool Strip. Now click with the CROSS cursor in the document Area and while keeping the mouse pressed, drag the mouse. The Ribbon
shows the two end points of the line. When the requisite length of the line has been achieved, leave the mouse. In the normal mode, this tool draws horizontal, vertical
and lines at 45 degrees.For a horizontal line, move the mouse horizontally. For a vertical straight line, move the mouse vertically. If a 45 degree line is required, move
the mouse such that the amount of movement both horizontally and vertically is same.
Read More Answers.
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Question # 86
How to group/Ungroup of objects in InPage?

Answer:-
Group feature allows you to group multiple objects as one. This enables you to treat the grouped objects as one entity and apply various object attributes to all of them
as one. Ungroup reverses this process.
Read More Answers.

Question # 87
How to use rotation tool in InPage?

Answer:-
Rotation Tool allows you to fix the axis around which the selected objects will be rotated. To rotate objects using this tool, you will first need to select the objects
using the ARROW Tool. Once the objects have been selected, you can choose the Rotation Tool. The cursor will change to Rotation Cursor. Clicking with this cursor
at a point will set the point around which the selected objects will be rotated. Keeping the mouse pressed, you can rotate the selected objects and let go off the mouse
the moment you have achieved the required rotation.
Read More Answers.

Question # 88
How to use text box linking tool in InPage?

Answer:-
* Ensure that you have created all the text boxes which are to be linked together. These text boxes may be on the same or on different pages.
* Next, click on the Linking Tool. You will notice that the cursor shape changes to the Cross cursor. And all the text boxes that can be linked will be displayed with
small square shaped multi colored boxes. These boxes appearing on the top left and bottom right of your text boxes signify the text boxes to which this text box is
linked to. If the text box is already part of a linked chain, then you will see incoming arrow to this box if there is a text box before this text box in the linked chain. On
the other hand if there are text boxes after this text box then you will be able to see arrows going out from this text box.
* To link a text box first you will need to click on the text box to which you wish this text box to link to. Lets call the clicked text box as the selected text box.
* You will notice that the cursor changes to the linked cursor when you bring the mouse over a text box which can be linked to the selected text box. You can now
click on this text box. You will find that a linked arrow is displayed from the original selected text box to the newly linked text box.
Read More Answers.

Question # 89
How to use text box delinking tool in InPage?

Answer:-
* Select this Delinking Tool.
You will notice that all the text boxes on the visible pages will display the linked to and linked from arrows. Thus you can see how a particular text box is linked in a
text chain.
* When you bring the cursor on text of a text box that forms part of a text chain, you will notice that the cursor changes to the 'Break Link' shape. If you now click the
text box when the shape of the cursor is 'Break Link', the link will break at that text box. In other words this text box and other subsequent text boxes in this text chain
will get separated from the existing chain and the text chain will break into two text chains.
Read More Answers.

Question # 90
How to Create a Square Text box in InPage?

Answer:-
If you keep the SHIFT pressed while creating the Text box, then the Text box is created with equal height and width.
Read More Answers.

Question # 91
How to use cursor shapes in InPage?

Answer:-
On moving the cursor on and around the boundary of the Text box, the cursor takes the ARROW shape. Inside the Text box, the cursor is displayed as the Dotted
IBEAM. If you now click inside the Text box with this Dotted IBEAM cursor, the cursor shape changes to IBEAM and a caret appears at the empty Text box is in
Text Edit mode and this is positioned at mouse click. The text box boundary from gray to black.
Read More Answers.

Question # 92
How to use Selecting/Moving/Resizing a text box in InPage?

Answer:-
To select, move and/or resize a Text box, you need to follow the steps as outlined above for selecting/moving/resizing an object.
Read More Answers.

Question # 93
How to use Text box border in InPage?

Answer:-
A Text box can be given a border. For this you need to specify the width of the border in points in ribbon and also the color by selecting the border color. Further this
border can be drawn inside text box or outside.
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Read More Answers.

Question # 94
How to use run around tool in InPage?

Answer:-
Whenever this Text box overlaps a Text box with text, then the text tends to flow away from this overlapping Text box. The amount by which the text flows away can
be specified by specifying the Run Around amount. See the Ribbon Object Attribute below.
Read More Answers.

Question # 95
How to use text wrap tool in InPage?

Answer:-
For a text chain, you can specify whether the text in this chain will wrap around objects or not. Thus irrespective of the fact that the object intersecting with this chain
has run around attribute as ON or OFF, if you set this attribute OFF, then text in this chain will not wrap around objects. For modifying this attribute, you will need to
go to Text Wrap menu item in the Format menu.
Read More Answers.

Question # 96
How to use Text Inset in InPage?

Answer:-
You can inset the text inside a Text box along left, right, top and bottom directions, so that the text now appears in smaller bounds inset from the Text Box boundary.
This is particularly useful for Text box framed with a border.
Read More Answers.

Question # 97
How to use columns tool in InPage?

Answer:-
You can specify the number of columns and the gutter size for a selected text box. By default a text box is assumed to be of single column.
Read More Answers.

Question # 98
How to use text edit mode in InPage?

Answer:-
If you move the mouse on top of a text box, then the cursor changes to DOTTED IBEAM cursor. On clicking the text box with this cursor, changes to SOLID
IBEAM. Also the boundary of the text box will change to black indicating the currently selected text Chain. In this mode the ribbon changes to Text Attributes mode.
Read More Answers.

Question # 99
How to use Hatch Patterns in InPage?

Answer:-
You can apply hatch patterns to text box. This allows you to output text super imposed on a surrounding hatch pattern.
Read More Answers.

Question # 100
How to use eliptical text boxs in InPage?

Answer:-
You can choose an Elliptical shape radio button in the Format Text box dialog. This allows you to have circular text boxes.
Read More Answers.

Question # 101
How to use Title Text box in InPage?

Answer:-
* Creation
During Creation, the height is assumed to be height of one line of text. Thus as a Title Box is constructed it gets a default height. 
* Line Direction within a Title Text box 
During Creation, if you move the mouse horizontally then the box is made with Line Direction set to Horizontal.
* Selection and Resizing
There are only two handles for resizing the Title Text box. And these handles resize the Title Text box only horizontally.
* Columns
Title Text boxes are always single column. You cannot change number of columns for Title Text box. Other attributes of the Text box apply as such to the Title Text
box.
Read More Answers.
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Question # 102
How to importing pictures in InPage?

Answer:-
You can crop the imported picture by pressing the mouse with the hand cursor and while keeping the mouse pressed, dragging the mouse so as to move the picture
within the picture box. On releasing the mouse, the final position of the picture inside the picture box is established. Rest of it is cropped and is not visible.
Read More Answers.

Question # 103
How to Moving/Resizing the picture box in InPage?

Answer:-
Moving and resizing of picture box works exactly as that of a Text box. You need to select the picture box first. Now the picture box can be moved either by entering
the new Origin values. Or with the help of a mouse by first clicking on the picture box (with the Arrow Tool) and while keeping the mouse pressed, moving the
mouse.
Similarly the picture box can be resized by either entering the new height and width values in the ribbon or moving the mouse on top of the picture box handles and
when the resize cursor appears pressing the mouse and dragging with the mouse pressed until the requisite dimensions have been achieved.
Read More Answers.

Question # 104
How to make picture box border in InPage?

Answer:-
Just as in Text box, a picture Box can be given a border. For this you need to specify the width of the border in points in the ribbon and also the color by selecting the
border color. Just as in Text box, the border Box can be Boxed inside or outside by selecting the appropriate icons from the ribbon. Default is Box Inside.
Read More Answers.

Question # 105
How to use run around button in InPage?

Answer:-
Whenever this picture box overlaps a Text box with text, then the text tends to flow away from this picture box. The amount by which the text flows can be specified
by clicking this button. In the displayed dialog, enter the Run Around values in all the four directions. If Run Around is to be disabled click on the Run Around check
box in the dialog to mark the check box off. On entering the required values, click OK button.
Read More Answers.

Question # 106
How to use picture inset button in InPage?

Answer:-
You can inset the picture along left, right, top and bottom directions so that the picture now appears in smaller bounds. This is particularly useful for picture box with
border Box.
Read More Answers.

Question # 107
How to creating a Square/Circular Graphic box in InPage?

Answer:-
If you keep the SHIFT pressed while creating the graphic box, then a graphic box is constructed with its height and width as equal. For the rectangular and rounded
rectangular graphic box, this implies a square graphic box. In the case of the Elliptical Graphic Box, you get a circular graphic box.
Read More Answers.

Question # 108
How to selecting a line pattern in InPage?

Answer:-
You can choose the kind of line patterns desired from the Line Pattern combo box. The patterns that you can select are:
* Solid
* Dotted
* Dashed
* Dash Dotted
* Double
* Thick Thin
* Thin Thick
Read More Answers.

Question # 109
How to entering English text in InPage?

Answer:-
To key text inside a text box, you first need to be in Text Editing Mode. The Text Editing Mode is identified by a blinking cursor in a text box. To enter into a Text
Editing Mode, first choose the IBEAM Tool from the Tool Bar. Now with the cursor appearing as a dotted IBEAM click on top of an intended text box. The outer
boundary of the text box will become black and a caret will start blinking. The blinking caret signifies the position in the text box where the text gets entered if you
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press any key. As you enter text, the caret moves to a new position.
If the text entered is more than the available space in the text box, then an overflow line is displayed at the bottom of the text box. This line signifies that the text has
overflowed the text box. 
You should now undertake one of the following measures:
* Increase the size of the text box
* Remove extra text
* Link this text box with a new text box so as to let the overflowed text flow into the new text box.
Read More Answers.

Question # 110
How to entering Sindhi text in InPage?

Answer:-
To enter text in Sindhi you need to first check whether Sindhi entry is enabled or not. This you can do by checking the Keyboard Preferences menu item in the
Preferences menu in edit menu. There is a check box called Enable Sindhi.
This check box should be checked on for enabling Sindhi entry. Now when you toggle the language either by pressing Control-Space or by selecting the Toggle
Language menu item. For Sindhi you have a standard Sindhi keyboard and only one font is chosen by default.
Read More Answers.

Question # 111
How to create style sheet in inpage?

Answer:-

No Answer is Posted For this Question

Be the First to Post Your Answer Now.
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